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READ ME FIRST
Welcome to Take Control of Switching to the Mac, version 1.5,
published in March 2008 by TidBITS Publishing Inc.
This book covers the steps needed to switch your computing life from
Windows to the Macintosh. It covers a lot of ground and by the end,
you’ll be running on your Mac with your files moved over from your
Windows PC, and you’ll know how to get around on your new Mac.
This book was written by Scott Knaster and edited by Caroline Rose.
Copyright © 2008, Scott Knaster. All rights reserved.
NOTE

This book was sponsored by Genentech. Special thanks to
Mark Altenberg and the reviewers at Genentech: Bill Bennett,
Dexter Chan, Kevin DuBay, Mark Jeffries, Jane Pray-Silver,
Jerome Rainey, and Kathryn Woods.

The price of this ebook is $10. If you want to share it with a friend,
please do so as you would a physical book. Click here to give your
friend a discount. Discounted classroom copies are also available.

Updates
We may offer free minor updates to this book. To read new information or find out about any new versions of this book’s PDF, click the
Check for Updates link on the cover. On the resulting Web page, you
can also sign up to be notified about updates to the PDF via email.
If you own only the print version of the book, contact us at
tc-comments@tidbits.com to obtain the ebook.

Page 2

This is a free sample of “Take Control of Switching to the Mac.”
Click here to buy the full 100-page ebook for only $10!

Basics
To understand this book, you don’t have to know anything about
Macintosh computers or how they work. However, a working
knowledge of Microsoft Windows will help. Also note the following
conventions:
• Menus: When I describe choosing a command from a menu in the
menu bar, I use an abbreviated form. For example, the abbreviated
form for the menu command that saves a file from Microsoft Word
is “File > Save.”
• Descriptions: When I describe hardware, such as the Mac keyboard, I’m assuming you have a newer Mac, made in 2005 or later.
Some descriptions—mostly minor details—don’t fit older Macs.
• Operating system terminology: The Macintosh operating
system is called Mac OS X (the X is pronounced “ten,” like the
Roman numeral). Major releases have both a number and a name.
The current release is 10.5 Leopard, and the previous version was
10.4 Tiger. The information herein is for both Leopard and Tiger,
except where otherwise noted.
• Path syntax: I occasionally use a path to show the location of
a file or folder in your file system. Path text is formatted in bold
type. For example, the Mac stores most utilities, such as Disk
Utility, in the Utilities folder. The path to Disk Utility is:
/Applications/Utilities/Disk Utility.
The slash at the start of the path tells you to start from the root
directory of the disk (similar to C: in Windows). You will also
encounter paths that begin with ~ (tilde), which is a shortcut for
any user’s home folder (similar to My Documents in Windows XP).
For example, if a person with the user name joe wants to install
fonts that only he can access, he would install them in his
~/Library/Fonts folder, which is just another way of writing
/Users/joe/Library/Fonts.
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What’s New in Version 1.5
I’ve refreshed Take Control of Switching to the Mac with updated
information throughout, and the update is extensive enough that
the version number has incremented from 1.0 to 1.5. In particular,
updates to the book include the following:
• I’ve revised the hardware descriptions to cover the latest (for now)
members of Apple’s product line in Choose the Best Mac for You
(p. 12).
• System software information throughout the book now includes
Leopard as well as Tiger.
• In a few cases where Windows Vista works differently from
Windows XP, I’ve added Vista-specific details.
• I’ve expanded the material about Moving digital music to cover
moving an iTunes library from a Windows PC to a new Mac (p. 53).
• I’ve added new information about running Windows on Intel Macs
in Run Windows on Your Mac (p. 90).
• I’ve updated and expanded the information about Web-based
applications.
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INTRODUCTION
There has never been a better time to be a Macintosh user. And
there’s never been a better time to become one if you’re not one
already. Thanks to the success of the iPod, iPhone, and recent
Macintosh models, Apple is enjoying a renaissance.
Macintosh users tend to be dedicated to their computer of choice.
There are reasons for this devotion. Apple’s fanatical attention to
detail and ease of use, and its high-tech-with-a-smile personality,
have been rewarded with loyal customers. And Mac users welcome
new members to their ranks.
In this book, I take you through the steps you need to switch your
computing life from Windows to Macintosh. By the end of the book,
you’ll be running on your Mac with your files moved over from your
Windows PC, and you’ll have a pretty good idea of how to get around
on your new Mac.
NOTE

Because I wrote this book with Macintosh beginners in mind, I
refer to many other Take Control titles that you might find useful. I don’t mean to be pushy by doing this, just thorough. This
book is designed to be useful all by itself, but if you want to find
out more about particular topics, I highly recommend other
Take Control titles.
I also suggest that you visit Apple’s Web site, especially
http://www.apple.com/macosx/, to learn more about topics
that interest you.
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SWITCHING TO THE MAC QUICK START
Switching from Windows to Macintosh doesn’t have to be hard.
Here’s an overview of how this book can help:
Get ready to switch:
• Why switch to the Mac? You likely have some ideas already; find
out more in What’s Cool about the Mac (p. 7), and balance that by
reading What’s Not So Cool (and What to Do about It) (p. 9).
• Be sure to Choose the Best Mac for You (p. 12).
Set up and use your Mac:
• If your Mac isn’t already set up, read Set Up Your Mac (p. 16).
• You can figure out a lot about a Mac by playing around with it, but
it’s better to first Understand User Interface Differences (p. 17).
• Next, to get ready for real work on your Mac, it’s time to Choose
Mac Applications (p. 40) and Move Your Data to Your Mac (p. 49).
Learn more about your Mac:
• You’ve got the basics down; now start digging in by reading Set Up
Multiple Users (p. 61) and Learn More about Finder Views (p. 62).
• Mac OS X includes a powerful tool for locating information on
your computer, as explained in Find Files with Spotlight (p. 64).
• Figure out how to use more of your Mac’s features. See Manage
Applications and Windows (p. 66), Use the Network (p. 70), and
Try Printing (p. 71).
• Apple offers an easy-to-use service that downloads new software to
your computer via the Internet. See Use Software Update (p. 72).
• Inevitably, you’ll run into problems. Find out how to solve them by
reading Glitches and Gotchas: Troubleshooting (p. 73).
• Expand your Mac mind by perusing Five Mac Features You Must
Learn (p. 77), followed by Five Useful Tips (p. 82).
Learn to live as a Mac user in a Windows world:
• You might want to know how to Share Documents with Windows
Users (p. 88) or how to Run Windows on Your Mac (p. 89).
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GET READY
OK! You’ve decided to take the plunge: you’re switching to the Mac.
Well, although you might think you’re a Mac island in a vast sea of
Windows, you’re far from alone. Apple is on a roll, and millions of
people are buying Macs, many of them for the first time.
When PCs seem to be everywhere, why should you be using a Mac?
Let’s take a look.
NOTE BEING PC: AREN’T THEY ALL PERSONAL COMPUTERS?
PC stands for personal computer, of course. But in this book
and in the common vernacular, PC is a shorthand term for a
personal computer running Microsoft Windows, as opposed to
a Macintosh computer running Mac OS X.

What’s Cool about the Mac
People have various reasons for buying and using Macintosh computers. Here are some common ones:
• Macs are stable. In general, fewer weird and unreliable things
happen when you’re using a Mac. Programs don’t crash or freeze
as often. Inexplicable problems, such as no sound from the
computer or the mouse not working, are almost unknown. And
although applications occasionally misbehave, full system crashes
(the equivalent of the dreaded Blue Screen of Death in Windows)
are rare.
• Mac users aren’t plagued by viruses. If you’re tired of cleaning viruses off your computer—and according to recent press
reports, some people are actually choosing to get rid of their PCs
rather than deal with virus infections—you’re bound to love having
a Mac. You won’t find viruses, worms, Trojan horses, spyware, or
other ill-meaning software ruining your computing experience in
Mac OS X.
• Almost everything is easier on a Mac. Ease of use is a
cornerstone of Macintosh hardware and software design. Macs
come with lots of friendly software included, and more is available
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from Apple and other companies. Because Mac users tend to
expect higher-quality software, other companies have to make
sure their Mac software is good, too.
• Apple provides excellent technical support. When
something does go wrong, or when you need a little help,
Apple offers assistance through its Web site, retail stores, and
phone centers. According to a recent survey in PC Magazine
(http://www.pcmag.com/article2/0,1895,2184103,00.asp)—
not exactly a bastion of Mac-positive press—Apple was ranked
first among computer makers in both technical support and
reliability (second place was “self-built computers”). The PC
Magazine article included this quote: “What's left to say? If you
buy a Mac, not only will you in all likelihood love it, but you’re
also going to recommend it to your friends while enjoying all
the time you can spend not fixing it.”
• Little things on the Mac seem to work better. Waking
your Mac from sleep (system standby) will make you smile:
the process is almost instantaneous. Joining a wireless network
usually happens automatically. The Mac is filled with small
touches that make your computing experience more enjoyable.
• Mac software has terrific graphics and high production
values. Apple sweats the details, and it shows. Macs are fun to
use, which makes it more pleasant (or perhaps tolerable) when
you have to work late on those spreadsheets; as famed computer
researcher Alan Kay has said, “Things that are fun are intrinsically
worth doing.” Apple also does a great job hiding the messy behindthe-scenes stuff that most users don’t want or need to see. In
contrast, Windows users must sometimes work through bits of
older software, such as DOS-style pathnames, that peek out from
the corners of the system.
• Now is a good time to switch. Reviewers and regular folks
have high praise for the latest version of the Mac’s operating system, Mac OS X 10.5 Leopard. Apple produces beautiful, innovative
hardware with plenty of features. The company is fiscally healthier
than ever (due in no small part to its success with digital music),
sparing us from those “Apple is going out of business” rumors
that used to pop up every year or so. And finding help for your
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Mac questions is easier than ever, thanks to the vast information
sources on the Internet as well as Apple’s large network of
company-owned retail stores (each of which includes a support
and repair department named, with typical Apple verve and
humility, the Genius Bar).

What’s Not So Cool (and What to Do about It)
After reading the previous section, you might wonder why everyone
on the planet doesn’t immediately pitch their Windows computers
out the, er, window and trade them in for Macs. As wonderful as
the Macintosh world sounds, there is some pain attached to making
the Mac switch. And, although you’ll find Mac fans who disagree,
Macintosh computers are not perfect, or even clearly superior to
Windows in every last detail. Here are a few of the problems you’re
likely to encounter:
• Switching is work. Even if your switch to the Mac improves
your life and work, the act of switching itself will have its difficult
moments. When you use Windows, you’re exercising muscle
memory and neural paths so familiar that you might not even
realize you’re using them. As you make the transition, you’ll have
to slow down and think about things that have heretofore been
automatic. Changes in terminology will annoy you. You’ll be
troubled by screen elements that look the same but act slightly
differently, or that have a completely different appearance but
perform familiar functions. One of the chief jobs of this book is
to help you with these issues—but they’ll still bug you, especially
during the early stages of your switch.
• In a Windows world, Macs can seem harder to use. Most
people who have used both systems agree that Macs are easier to
use than Windows PCs. But there are many, many more PCs in the
world than there are Macs. So when something goes wrong with
your Windows PC, there are usually more resources around to help
you: more neighbors, more family computer gurus, more material
online, more technical support at the office. This produces a paradoxical network effect: although Macs are generally easier than
PCs, they can actually become more troublesome than PCs when
you need help.
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Apple helps you overcome this problem by offering one-stop
shopping through its online and physical stores. Like most companies, Apple provides support via the Web. But Apple goes far
beyond most others with its Apple Stores. Apple has more than
200 retail stores around the world, and more opening every
month. Each store includes a Genius Bar, where you can obtain
excellent service and support for your Mac, as I mentioned earlier.
Employers provide varying degrees of help for Macintosh users.
If your IT department officially supports Macs, be sure to take
advantage of any services offered there. At most companies, Mac
users are in the minority, so it’s a good idea to join (or form) a
community, such as a mailing list or a user group (see the list at
http://www.apple.com/usergroups/), that provides mutual aid.
Of course, Macs typically need less technical support than Windows,
so having fewer support resources becomes less of an issue.
• Connecting to Windows networks can be tricky. Apple
spends a lot of time and effort giving its computers the ability to
play nice with Windows. This includes such features as mounting
Windows shares (network volumes), connecting to printers on
Windows networks, and working with Windows-formatted disks.
But sometimes it seems like Apple’s heart isn’t in it. Mac support
for working with Windows computers and networks is often buggy
and incomplete. And who can blame Apple? No doubt it’s a lot
more interesting to create the latest visually stunning Mac OS X
feature than to fix a bug in how Macs share files with PCs. But for
those of us who need that Windows support, it’s a pain.
• Some applications don’t have Mac versions. Because there
are so many more PCs than Macs, some companies decide to
produce software only for Windows. Others have both Mac and
Windows versions but let the Mac versions trail behind in features.
You can find at least one Mac OS X application in every major
category. Because Mac users have high standards, these programs
are often excellent. But in many categories PC users have more
options to choose from. Specialized programs can present bigger
problems: some niche software is simply not available on the Mac.
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If you rely on one of these unavailable programs, you have several
options. You can sometimes find another program that’s similar to
yours and adapt your work to use it. A few programs provide Web
interfaces that don’t care whether you’re using a Mac or Windows.
But in some cases you might have to continue using specialized
Windows applications. If you find yourself in that situation, you
always have the option of running Windows on your Mac. I cover
this topic in more detail in Choose Mac Applications and Run
Windows on Your Mac.
• A Mac is a computer, and computers can be balky. If you’re
used to Windows, you’ll experience fewer instances of odd and
annoying behavior on your Mac—but you’ll still see it sometimes,
unfortunately. This includes applications growing sluggish, freezing, or quitting unexpectedly, features working strangely, and
network troubles. Although you can’t eliminate these problems,
you can learn how to avoid them, and to recover from them
gracefully when they do happen. I cover this in Glitches and
Gotchas: Troubleshooting.
Something else to remember is that although Macs are essentially
virus-free as of this writing, this may not be the case forever. In
fact, from time to time, programmers have announced the creation
of a Mac virus or worm as a proof-of-concept demonstration, and a
few Mac viruses have even been found “in the wild.” But Mac users
today simply aren’t affected by viruses.
Why haven’t Macs been hit by viruses, worms, and the like? The
answer to that question is hotly debated. The factors usually cited
include:
◊

Mac OS X is built on UNIX, a mature and solid operating
system.

◊

Mac OS X as installed is configured to prevent intrusions from
bad things on the Internet.

◊

Macs are so few in number compared to Windows computers
that nobody bothers to attack them

◊

Virus writers hate Windows, but they leave Macs alone.

I believe each of these plays a part in the lack of Mac viruses, but
nobody really knows.
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Choose the Best Mac for You
When Steve Jobs returned to Apple in 1997, he ridiculed the
company’s confusing product line, which included many Macs
with similar designations such as Performa 6110, Performa 6112,
and Performa 6115 (not to mention the Performas 6116 and 6118).
How, Jobs reasonably asked, could customers understand the difference between these models when even people working at Apple
couldn’t tell?
To simplify, Apple changed the product line by dividing it into
four simple categories: desktop and portable computers, each with
versions for consumer and professional users. Although the distinctions have blurred and the product lines have become somewhat
more complex, these categories are still valid today, more than a
decade after Apple adopted them.
When deciding which Macintosh is right for you, your first decision
should be whether to choose a desktop or a portable computer.
Get a portable (also called a laptop or notebook) if you want to be
as mobile as possible, carrying your work with you around the office
and the house. Pick a desktop model if you need processing power
or a big screen, or if you don’t care about portability.
TIP LESS IS MORE
You’ll usually pay more for the same capabilities in a portable
computer than in a desktop. That’s because cramming components into a portable requires more advanced engineering and
more precise manufacturing than building a relatively spacious
desktop model. So, price versus performance is another factor
to consider when choosing desktop or portable.

Here’s a brief look at the Mac models available now in each category:
• Desktop computers: Mac Pro is Apple’s professional-grade
desktop line (Figure 1). These computers possess the most
impressive specs of any in Apple’s stable, including the fastest
microprocessors, largest possible memory and hard disk storage,
and most powerful graphics hardware.
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FIGURE 1

Mac Pro, Apple’s most powerful line of computers.

The venerable iMac and the upstart Mac mini are Apple’s low-end
desktop models:

FIGURE 2

◊

The iMac (Figure 2) plays hide-the-computer, placing all the
electronics inside the same thin case that holds the display, so
all you see is screen, keyboard, and mouse.

◊

The Mac mini (Figure 3) is nearly the opposite: nothing but
a tiny box (less than 85 cubic inches) containing the basic computer. You add your own external display, along with keyboard
and mouse, to complete the system. The display, keyboard,
and mouse needn’t come from Apple; you can use inexpensive
ones or spares to keep your total cost down. Because the mini
includes only essential parts, Apple can price it low ($599 for
the basic model).
iMac with wired keyboard and mouse,
and wireless remote control.
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FIGURE 3

Mac mini, the smallest
and least expensive
Macintosh computer ever.
You supply the keyboard,
mouse, and display.

• Portable computers: Apple’s consumer-level portable is the
MacBook; the professional model is, naturally, the MacBook Pro
(Figure 4 and Figure 5). The current editions of these two lines
are similar in many ways, and the machines are a lot alike internally. The main advantages of the MacBook Pro are its options for
a larger screen, faster processor, more memory, PC Card slot, and
better graphics. You can compare MacBook and MacBook Pro
features by going to http://store.apple.com/Catalog/US/Images/
comparison_chart.html.
FIGURE 4

The MacBook Pro is available in 15- and 17-inch
screen sizes. It includes
nifty features such as a
backlit keyboard.

FIGURE 5

The MacBook is Apple’s
less expensive portable
computer. It lacks a few
of the MacBook Pro’s
features and is available
only with a 13-inch
screen, but it can cost
substantially less. And
it comes in black.

Page 14

This is a free sample of “Take Control of Switching to the Mac.”
Click here to buy the full 100-page ebook for only $10!

Apple’s third portable model, the ultra-light MacBook Air (Figure 6),
weighs in at just 3 pounds and measures just 0.76 inches at its thickest point. The MacBook Air attains its slim size by sacrificing features,
such as an optical drive and Ethernet and some other connectors,
although it sports a full-size keyboard and 13-inch display. To learn
more about the pros and cons of the MacBook Air, see Jason Snell’s
detailed review in Macworld at http://www.macworld.com/
article/131864/2008/01/macbookair.html.
FIGURE 6

Introduced in January
2008, the MacBook Air
has a unique feature set
and is priced between
the MacBook and the
MacBook Pro.

NOTE

Although this general description of Apple’s Macintosh lines is
correct as of this writing, Apple is always making new stuff, so
the product line is bound to change in the future.
I don’t know anything about Apple’s plans for new Macs, and
(almost) nobody else does either. Apple loves to surprise everyone and is notorious for its secrecy. Of course, this vacuum of
official information leads to a flood of speculation and rumors
about what Apple is up to. Rumormongering is a popular
pastime among Macintosh fans.

For detailed information about selecting the right Mac for you,
I suggest that you read Take Control of Buying a Mac.
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SET UP AND USE YOUR MAC
Now it’s time to go to your workspace, stretch out your fingers, and
set up and use your Mac. At this point, you might find it helpful to
recall the words printed in large, friendly letters on the cover of the
Hitchhiker’s Guide to the Galaxy: Don’t Panic. You’ll see and experience all sorts of strange new things, but it’s going to be OK. It’ll be fun
and rewarding, too.
NOTE

Before you go ahead with setting up your Mac, make sure this
is a good time to proceed. You should clear at least a few hours
on your schedule to make the transition and move your data;
a weekend is ideal. Although you might be itching to start working with your Mac as soon as possible, it’s not a good idea to
begin the process 10 minutes before you leave for an appointment. If you use your Mac at work, the beginning of a new
project is an excellent time to switch.
You should choose a point of relative calm in your computing
life—not, for example, while you’re simultaneously trying to
finish up your company’s annual plan.

Set Up Your Mac
If you haven’t already done so, take your Mac out of its box and set
it up in your workspace. Connect the mouse and the keyboard (if it’s
not built in, as on a portable) to the USB ports on the Mac. Make sure
you’ve plugged your Mac into AC power.
Turn your Mac on by pressing the Power button—that’s the round
one marked with a circle broken by a vertical bar. Enjoy the welcome
from Apple, and then follow the steps and answer the questions that
appear on the screen as the first-time setup program runs.
TIP

The Mac emits a melodious tone when it starts up. If you’re
turning it on for the first time late at night at home, make sure
the door to the room is closed if anyone is sleeping.
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LEARN MORE ABOUT YOUR MAC
If you’ve been playing along this far, you’re now using your Mac,
you’ve figured out which applications to use, and your files and
settings are there with you. Congratulations! This section tells you
more about how to use your Mac.

Set Up Multiple Users
Mac OS X provides an easy, powerful way for more than one person
to use a single Mac and each get a private space. To see how it works,
open the Accounts preference pane in System Preferences. The left
side of the pane lists the user accounts registered on the computer.
If you set up your computer yourself, you’ll probably see only your
name on the left side. If you got your computer from your company’s
IT department, there might be additional accounts.
You might want to add accounts for your family members or (less
likely) your coworkers. Note that a description appears under each
account name on the left side: Admin, Standard, Managed, or (in
Leopard) Sharing Only. To add an account, your own account must
be of the Admin type. At some organizations, the IT department
doesn’t give everyone Admin access, so you might not be able to add
accounts. If you do have an Admin account, you first have to prove
you’re who you say you are, through a process called authenticating:
click the padlock at the lower left ( ) and enter your password to
unlock it. Once the padlock opens, click the
button just above
it to add an account.
Holders of Admin accounts, such as parents and other authority
figures, can create Standard and Managed accounts that are limited
in certain ways. For example, an administrator can limit a Standard
or Managed account to a fixed set of applications, allow or disallow
CD and DVD burning, and create a list of permitted Web sites for
Safari. Leopard revamps and expands these “parental controls” to
include time limits, logs of Web sites visited, and more.
Once you’ve set up multiple accounts, users can easily switch among
them using Fast User Switching. Turn on Fast User Switching by
going to the Accounts preference pane in System Preferences, clicking
Login Options at the bottom left, and then selecting Enable Fast User
Switching. You’ll see your name (or your account’s icon) appear at the
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LIVE AS A MAC USER IN A WINDOWS WORLD
Let’s face it: the vast majority of our family members, friends, and
coworkers have managed to resist the Mac’s charms so far. This can
make for some rough edges as you transition from Windows and
become a Mac user. In this section, I cover some of the difficulties you
might run into as you continue to work with Windows users, along with
possible solutions.

Share Documents with Windows Users
You can exchange many kinds of files, including Word, Excel,
PowerPoint, GIF, JPG, and PDF files, with your Windows counterparts. Usually, you’ll share documents via email, but any form
of transfer is fine. Although sharing documents across operating
systems works well, here are some troublesome areas to be aware of:
• Many Excel documents include macros, which are generally
portable between Mac and Windows. The major exception is
macros that use ActiveX controls in Windows: those don’t work
on Macs and can’t be converted.
• PowerPoint presentations can have problems moving from Mac
to Windows if they include movies. Movies created on the Mac are
typically in QuickTime format, but for them to work in PowerPoint
in Windows you must convert them to AVI format. Apple’s QuickTime Pro lets you export QuickTime movies to other formats,
including AVI.
• You’ll occasionally have problems with documents that appear
or print slightly differently after they cross operating systems.
Sometimes you can fix these problems by avoiding exotic fonts
and sticking with a well-known set.
In particular, some fonts on the Mac are installed in Windows
only if the computer has Microsoft Publisher. If you send documents with these fonts to Windows users, they won’t appear or
print correctly if the recipient doesn’t have Publisher.
Microsoft Office 2004 and 2008 for Mac include a helpful feature
that tries to determine whether a document will have any problems
when viewed with Windows. To use this feature, choose Tools >
Compatibility Report in the Mac versions of Word, Excel, or
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GLOSSARY
In this glossary, you’ll find definitions for a number of Mac-related
terms, which may also appear in the text in blue. If you’re reading this
book on a computer, you can click a blue term in the text to move to
the glossary page that defines it and then return to where you were by
using a menu command or keyboard shortcut, as noted in Table 4.
Table 4: Navigation Tips
Viewing
Software

Menu Command

Keyboard Shortcut

Adobe Acrobat
versions 6–8

View > Go To > Previous View

Command-Left arrow

Adobe Acrobat
version 5

Document > Go To > Previous View

Command-Left arrow

Preview

Go > Back

Command-[

NOTE

If you know the name of a Windows term and you want to find
out what the Mac equivalent is, see Table 2.

application menu: The second menu in the menu bar. Its title is
the name of the current application, and it contains commands for
that application.
authenticating: The process of providing your user name and your
password, as requested by your Mac before it will let you change an
important setting.
brushed metal: A type of Mac OS X window that looks as if it’s
made of metal and can be dragged by its edges. The Finder and
QuickTime Player are examples of applications that use brushed
metal windows. (See Figure 10, p. 27.)
contacts: A collection of names and addresses, primarily used by
email programs. Some email programs call this the address book.
disclosure triangle: The small triangle next to a folder in a Finder
list view window, also sometimes called expansion triangle. Click it to
show or hide the contents of the folder. Disclosure triangles appear in
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LEARN MORE
Moving from Windows to Mac is a very popular topic these days, and
it seems to be getting more popular all the time. In this section, I’ve
listed some of the best resources available for intrepid Windows-toMac switchers.

Books
In this book, I’ve tried to present the fundamentals of switching to
the Mac in a relatively small number of pages. If you’d like a lot more
material about switching (for a higher price, of course), take a look at
one of these books:
• Switching to the Mac: The Missing Manual, Leopard Edition
by David Pogue, ISBN 0-596-51412-3
http://www.amazon.com/gp/product/0596514123/
• Switching to the Mac: The Missing Manual, Tiger Edition
by David Pogue and Adam Goldstein, ISBN 0-596-00660-8
http://www.amazon.com/gp/product/0596006608/

Web Sites
Software downloads and services:
• Firefox browser: http://www.getfirefox.com/
• VLC video player: http://www.videolan.org/
• Software from Apple and others:
http://www.apple.com/downloads/macosx/
• Audion music player (plays and converts WMA files):
http://www.panic.com/audion/
• Email conversion tools: http://www.emailman.com/
• Outlook2Mac mail conversion utility:
http://www.littlemachines.com/
• Eudora vCard Export conversion utility:
http://homepage.mac.com/aamann/
• TinkerTool utility: http://www.bresink.de/osx/TinkerTool.html
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